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The PADD                                    August 2008 

Hello Everyone! 
 What a sweltering month August is!  Irony then, that a snowball planet shall grace the 
cover of this month’s issue, is it not?  I know a lot of college students are starting their fall 
semester up around this time (myself included), so we’ve all been a little pressured to get 
everything together and sent out in time.  Once again, Laria Moonmoth and Rico Novas 
couldn’t make it in this month, but the PADD is a beefy collection of text one way or 
another (and if it’s ever not, I’ll make it beefy!  ::snaps whip::))  Once again, Carrissa Hunter 
and Wilhelmina Sternenschnuppe have returned with their respected articles, this time 
exploring what that elusive operations department actually does, and Robb Clemens as 
we travel back in time with Dr. Mini.  The USF Movie Review team is going goo-goo ga-ga 
over Star Wars this month, and Robb Clemens expands his ever growing database of 
delicious goodness with the USF Cookbook!  Ever wished you could change the eye color 
of your bio image, or make that Bolian you always wanted?  (ew…) Well never fear, for the 
topic of this month’s USF Photoshop Tutorial is nothing less than the alpha and omega of 
coloring with Photoshop!  And of course, as we save the best for last, read all the greatest 
happenings of Trek in the Star Trek News section!  I needn’t say we are a beefy magazine 

deed. in
 

Stay Frosty (especially now…), 
 

Lieutenant Commander Havraha cha’AAnikh 
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Star Trek News 
 
tar Trek XI Isn't A Remake, Says Pegg. S

 
By T'Bonz 
August 27, 2008 - 12:23 AM 

Just because Star Trek XI uses different actors for the parts of Kirk and his crew, that doesn't 
mean it's a remake according to Simon Pegg.  

As reported by Starlog, Pegg, speaking about both Star Trek and Star Wars, gave his view 
on the opinion of many that Star Trek XI is a reboot of the franchise. "The weird thing," said 
Pegg, "and I think this goes for both 'Star Trek' and 'Doctor Who', is that neither of them are 
remakes."  

"I often see 'Star Trek' being referred to as a remake, and it really isn't," Pegg continued. "It's 
another 'Star Trek' film; it's another movie in the series. It's the continuing mission."  

Pegg is not the only one who believes that Star Trek XI is more than just a new Kirk, Spock 
and Kirk, according to TrekMovie.com. In a previous interview, Executive Producer Roberto 
Orci had this to say when asked if the movie was a remake, reboot or prequel. "In some 
senses it is a prequel, but the word I would use, which is how Damon [Lindelof] describes it, 
is a re-invigoration or re-vitalization."  

In other Star Trek XI news, J.J. Abrams confirmed that William Shatner is not in Star Trek XI 
according to Trekmovie.com. "The only cast member from the original films is Nimoy," said 
Abrams, in response to a question asking if the actor who played the original Captain Kirk 
would be in the movie. Abrams also told fans that he was hoping that the "final cut" of Star 
Trek XI was only "a few weeks away."  

 
Star Trek Online Q&A  

y Kestral http://www.startrekonline.com/dev_blog/ask_cryptic_8-25-08
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In our first round of developer Q&As, we tackle community submitted questions about 
canon, customization, music, exploration and more. Thanks very much to Al "Captain Geko" 
Rivera and Craig "Zinc" Zinkievich for their answers!  

Will Star Trek Online be considered canon in any respect? How much of the game will stick 
to the canon?  

Al "Captain Geko" Rivera (lead designer): Every series and movie is considered canon, and 
we are staying very true to this in our development. Star Trek is rich with lore and history, and 
there is a great deal of material to build upon as we move into the 25th century with Star 

http://www.treknation.com/about/contact.shtml
http://www.starlog.com/
http://trekmovie.com/
http://trekmovie.com/


 
Trek Online. We are working with CBS to ensure that everything we create is true to Trek and 
makes sense.  

We know that fans want to play Star Trek Online because they want to explore the Star Trek 
universe, and we are striving to deliver as authentic an experience as possible. Our team 
has seen all the shows and movies and we're watching them again ev
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ery single day. We 

n Star Trek Online as well.  

k 

ity when it comes to their characters. We are fully utilizing our 

Star Trek has had some of the best scores and soundtracks ever made associated with it in 
the past. Can we expect just as much attention to go into the sound effects, music and 
ambience as we would h

We are also working closely with CBS, 

 

 
 

are also studying other soft canon resources such as novels and comics. From those, we are 
looking for inspiration and references to further enhance our game. Where it makes sense, 
we will include some soft canon elements i

Will I be able to trick out my Bird of Prey with green flame decals to show off when I decloa
to "pwn Federation nubs"?  

Captain Geko: One of Cryptic Studios' hallmark features in all of its games is giving players 
ultimate customizabil
character creation technology in Star Trek Online to include customizing both characters 
and starships. You will be able to customize your ship's geometry, as well as its color, decals 
and fleet insignia.  

opefully see in the graphics area?  

Captain Geko: Luckily, Michael Henry, our director of audio, is a 
longtime Star Trek fan and an accomplished musician and 
composer. Trust us when we say that Michael will be creating 
authentic Star Trek music scores and ambience – and not even a 
Gorn attack can stop him! 
and its team has provided us with access to a massive library of 
sound effects from all of the series and movies. So phasers will 

sound exactly like phasers should.  

If I'm not in the mood for ship combat, gaining Starfleet's favor or earning credits doing jobs
for Quark, in what ways will I be able to advance my character doing what I want to do 
most: exploring the galaxy?  

Craig "Zinc" Zinkievich (executive producer): Exploration will never take a backseat in Star 
Trek Online. Heck – in all the series, Starfleet is always sending captains off to chart new 
systems or classify nebulas. So we don't view exploration as a "break" from other gameplay
– it's integral. Expect to be encouraged to boldly go! And as an incentive to explore space,
discovering new civilizations is one of the major ways to open up new resources and 
equipment and make new alien recruits available to you, your fleet and your faction!  

My question is whether the universe will be static. For example, if I log off World of Warcraft 
and then login a week later everything is pretty much still the same. Nothing has really 
changed. Will the world be dynamic in STO?  



 
Zinc: The universe of Star Trek Online is shaped and changed by the actions of the players. 
The Federation and the Klingon Empire will be competing for influence and resources 
throughout the galaxy and players can influence the results through PvP battles and a 
system we're calling Competitive PvE.  
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ys happening – expect to see new 

u logged in. Your actions 
ith the Federation or the 

ngons.  

The actions, victories and defeats of you and your fa
. Exploration is alwahistory of Star Trek Online unfolds

planets and races discovered that were unknown the last time yo
ould be the deciding factor on whether these new planets side wc
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Star Trek' attraction to be decommissioned Sept. 1  
By Richard Velotta / Staff Writer 
http://www.inbusinesslasvegas.com/2008/08/22/tourgame.html 

anceled - that is, 

n that features two 
y of the Future" 

as Hilton in trouble 
with gaming regulators, who frowned on children who 

 

would close Sept. 1 because the landlord 
n, 

 
 

 

 

Star Trek: The Experience has lived long and prospered.  

But now, like a television series that has worn out its welcome, it is being c
the tourist attraction at the Las Vegas Hilton is closing its doors.  

Only unlike a TV show that has run out of gas and scores poorly in the weekly Nielsen 
ratings, Star Trek: The Experience seems to be as popular now as it was when it opened Jan. 
3, 1998, even though there was a reported lull in attendance in midlife.  

"I went out the other day, and the lines extended back into the corridor," Chad Boutte, 
operations manager and director of marketing of the Experience, said of the visitors who 
pay $40 or more per person to get into the 65,000-square-foot attractio
interactive experiences and a "Histor
museum of "Star Trek" lore.  

Those long lines once got the Las Veg

were waiting to get in standing next to slot machines near 
the attraction's entrance. The Hilton eventually had to pay 
a fine.  

So why is it closing if it's so popular?  

That's what millions of "Star Trek" fans are asking, and no one seems to have a good answer. 

On June 30, it was announced the Experience 

 

Las Vegas Hilton and tenant Cedar Fair Entertainment Co., operators of the attractio
couldn't reach agreement on a lease. The current lease is up Dec. 31, and when an
agreement couldn't be reached by the end of June, it was determined that the company
would need three months to break down the sets, box up the props to send back to "Star 
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ek"-

er come back to Las Vegas again," Boutte said.  

uthfully proclaim that he went from Borg drone 
or of the Alzheimer's Association in New 

 
Borg Invasion 4-D attraction. He was one of the Borg drones 

arfleet officer before deciding to get back in the administrative 
side of business.  

le after it's closed to finish up a few things, but I honestly don't 

ery 20 minutes, every day.  

Trek" franchise owner CBS, sweep the floors and turn the site back to what it was before the
place opened.  

Isn't it ironic? For a show filled with optimism about mankind's future with characters 
endowed with attitudes of universal coexistence and the ability to resolve disputes 
peacefully, a stalled lease agreement is the attraction's demise. It seems so un-"Star Tr
like.  

Boutte said the "Star Trek" franchise still has legs, especially since an 11th "Star Trek" movie is 
scheduled for release in May and the various TV series spinoffs appear regularly on cable 
channels such as Sci Fi.  

Boutte said he has received more than 5,000 e-mails and a nearly 6-foot stack of petitions 
from fans trying to stop the closure. Many of them are directing their anger at the Las 
Vegas Hilton.  

"Some of them are saying they are so upset that they'll never stay at a Hilton again, and 
some of them say they'll nev

Boutte has enjoyed his Las Vegas experience and has his own interesting history.  

He may be the only person to be able to tr
to corporate management. The former direct
Mexico had a passion for his acting hobby and moved to Las Vegas five years ago when
the Experience opened the 
attacking guests.  

He later took the role of a St

Now, he doesn't know what he'll do next.  

"I'll probably be here awhi
know what's next," he said.  

He and his colleagues are proud of what they've done over the more than 10 1/2 years the 
attraction has been open.  

"I've worked in many different venues, but this was first time I have ever had a staff so 
dedicated to their jobs," said Boutte, who guaranteed that many tears would be shed as 
the closing date nears.  

He said although the performances in the interactive experience aren't the longest running 
in Las Vegas, he's confident the actors have performed the most shows in town, considering 
they occur ev
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 some kind of theater show or 

es, the Experience's last public show will occur around 8:30 p.m. Then, it 
t with a guest list of hard-core fans compiled by the attraction's 

er the years one last crack at mixing with Borg, Klingon 

P list and have offered big bucks 

 Boutte said there would be a decommissioning 
es a ship for the last time, open to the 

 big piece of the franchise is that the heroes 
er day.  

After all, the company runs Knott's Berry Farm in Buena Park, Calif., and its signature theme 
ark, Cedar Point, in Sandusky, Ohio.  

g 

Boutte said he would forever cherish memories of seeing cast members interact with 
people with disabilities who have said that in the "Star Trek" universe, they feel as if they're 
accepted as they are and could escape the world of their physical ailments.  

Boutte said he has no idea what would happen next in the Experience's space. Las Vegas
Hilton spokesman Ira David Sternberg echoed that, saying it hasn't been determined what 
will go there.  

"There's no timetable, no rush to make a decision," Sternberg said. "I think all options are on 
the table. It's an interesting venue."  

Those options could include another themed experience,
more gaming positions, he said. Rumors that the company is in negotiations with Michael 
Jackson for a show (which, incidentally, has put Jackson on many Trekkers' black list) are 
just that, rumors, Sternberg said.  

My wife suggested that the Hilton could be in negotiations to offer "Batman: The Gotham 
Experience," but I don't think I'd put my money there.  

When Sept. 1 arriv
will be open for a VIP even
management to give those loyal ov
and Ferengi. Some celebrities have been invited as well.  

Boutte said hundreds of fans have asked to get on the VI
to go on the last "mission." He's considering auctioning five tickets for the final mission on 
eBay because of the tremendous interest.  

At 10 p.m. at the entrance to the attraction,
ceremony, the kind that occurs when a crew leav
public.  

And that will be the end.  

Or will it? As most "Star Trek" fans know, a
emerge from overwhelming odds to fight anoth

Is it possible that Star Trek: The Experience could emerge at another Cedar Fair location? 

p

Trekkers the world over are awaiting the answer.  

The Collective: Exclusive First Look At 2008’s Johnny Lightnin
Ship Toys August 21, 2008 
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by John Tenuto , Filed under: Toys , trackback  

ie.com/2008/08/21/the-collective-first-look-at-2008s-johnny-lighting-ship-toys/http://trekmov  

 

s of Star Trek" ships 
line. Plus we

 Ov  new set (or 
‘wav th two waves of 

ailable for preorder 
now, ckly.  

The ruiser with 
Star Trek 

III The Search for Spock hnny Lighting ships 
are now availa

 
Wave 5 of Johnny Lightning ships  

This October, Wave 6 includes the Borg Cube with explosions and phasers, a Romulan D7 
Battlecruiser (based on the TAS design), the USS Yamato (from TNG episode "Contagion" 
and others), and the USS Excalibur (TOS episodes "Court Martial" and "The Ultimate 
Computer"). The originally planned USS Voyager with Borg detailing has been delayed (and 
was replaced by the TAS Romulan Battlecruiser). 

Johnny Lightning, the makers of small, fun and inexpensive plastic toys has more Star Trek 
ships on the way for the 2008 holiday season. Trekmovie.com brings you exclusive hi 
resolution photos of the latest waves of the Johnny Lightning "Legend

 take a look at the past offerings in this excellent collection. 

er each of the last four years Johnny Lighting have issued
e’) of Star Trek ships toys. This autumn, we get a treat wi

Johnny Lightning ships headed your way. Both are av
 which is a good idea because these tend to sell out qui

Wave 5 includes the Enterprise NX-01, a Klingon D7 Battlec
explosion detailing, the self-destructed version of the Enterprise from 

, and the Shuttlecraft Galileo II. Wave 5 of the Jo
ble for pre-order online and should be in stores soon.  

http://img.trekmovie.com/images/merchandise/jlw5.jpg�


 

 

 

 
Wave 6 of Johnny Lightning ships  

[NOTE: Romulan Battlecruiser shown with Klingon base, not final product]  

Both waves will again feature the "White Lightning" editions, which are limited variant 
versions of the ships. Interestingly, Johnny Lightning’s new packaging retains its unique 
design yet incorporates some of the features of the unified packaging.  

 
Packaging for White Lightning version 
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http://img.trekmovie.com/images/merchandise/jlw6romulan.jpg�
http://img.trekmovie.com/images/merchandise/jlw6borg.jpg�
http://img.trekmovie.com/images/merchandise/jlw6excal.jpg�
http://img.trekmovie.com/images/merchandise/jlw6yam.jpg�
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As usual for Johnny Lighting, these ships are very cool and perfect for display at about four 
inches long. Johnny Lightning is famous in the world of metal car collecting, offering quality 
replicas of famous automobile models. They also make some of the best Star Trek 
collectibles in recent years, both because of the variety and affordable price. The Johnny 
Lightning plastic Star Trek ships are inexpensive (about $6-7 each or packaged together for 
around $20 for all four in a wave). Yet, the ships are of good quality and detailing, with fun 
features such as "cloaked" and "battle damaged" versions. Especially impressive is that JL 
has released ships that have received little attention from previous licensees, such as the 
USS Yamato or the NX-01. The White Lightning versions are fun and these limited edition 
ships tend to go for four times their price at online auctions. Johnny Lightning promises more 
ships in 2009 for Star Trek fans.  

You can order these items online from New Force Comics (www.newforcecomics.com) 
and other retailers.  

 Four years of fun little ships 
Johnny Lightning has been making these ships from 2004, with this year being the first that 
fans are getting two waves. Trekmovie.com provides you with a checklist of all the JL ships, 
noting White Lightnings when available. (Please be aware that these ships have been so 
popular that waves one to four are available mostly at online auctions now as retailers 
have sold out.) 

Wave One (2004) 
Each of these toys included a sticker appropriate to the ship’s affiliation. Each ship was also 
available in the "White Lightning" variation. 

• NX-01 Enterprise 
• USS Enterprise NCC 1701 

Galileo (from TV era) • Shuttlecraft 
• USS Reliant 

 era) • Romulan Bird of Prey (TV
Klingon D7 Battlecruiser • 

Wave Two (2005) 
Each of these toys included a communication badge patch. Each ship was also available 
in the "White Lightning" variation. 

• NX-01 Enterprise (battle damaged) 
• USS Enterprise NCC 1701 (battle damaged)  
• USS Enterprise NCC 1701 (TMP and TWOK edition)  

 battle damaged)  • USS Enterprise NCC 1701 (TWOK
• USS Reliant (battle damaged)  
• Klingon D7 Battlecruiser (cloaked, meaning it is clear plastic)  

Wave Three (2006) 
The "White Lightnings" in this wave included cloaked versions of the Enterprise D and ISS NX-
01 Enterprise. The cloaked Romulan Bird of Prey White Lightning had the insignia visible on 
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lor, befitting the color associated with the aliens starting 

) 

• hings edition) 
r NCC 74656 Borg Cube 

the clear plastic, as if the ship was in the middle of activating the cloak. The Borg White 
Lightning was an entirely green co
with First Contact and Voyager. 

• ISS NX-01 Enterprise (Mirror Universe
• Romulan Bird of Prey (cloaked) 
• USS Enterprise NCC 1701 D 

USS Enterprise NCC 1701 D (All Good T
• USS Voyage

Wave Four (2007) 
This wave had no known "White Lightning" versions, although it continued the trend of 
featuring a variety of ships from a variety of feature films and television episodes. It also 

 Web")  

isode)  
• )  

• Borg Cube (Fir ntact edition) 

 

 

features the only DS9 ship (USS Miranda) yet available. 

• USS Defiant NCC-1764 (from the episode "The Tholian
• USS Enterprise NCC 1701 A  

n)  • USS Enterprise NCC 1701 D (feature film era versio
rifice of Angels" DS9 ep• USS Majestic NCC 31060 (from "Sac

USS Voyager NCC 74656 (with gear for planets
st Co

 

 

 

 

 

 

 

 



 

 
Star Trek Online Teaser Trailer Revealed! 
 

 
 
Earlier in this month, Cryptic Studios revealed a teaser trailer for their new MMORPG “Star 
Trek Online”.  It certainly does look action packed, and it gives us our first short sneak 
preview of what character models, space battles, and the new USS Enterprise will look like!  

.com/videosDownload it for yourself here! - http://startrekonline  
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Star Trek Comics   
 
Last month we featured Trek Life by David Reddick.  This month we feature a few more of 

is creations such as Rod & Barry.  And of course… The Trek Life.   h
 
P.S.  this is not meant as an infringement on CBS or Paramount or anyone else…we (the 
fans) just like the comics and are not pleased that Star Trek.COM is not showing them 

nymore.   a
 

 
13

 

 
BY David Reddick   

 
 
 
The Red Shirts of the Fleet. 



 

Star Trek Comics  
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USF Movie Review 

With Fleet Captain Rylan J Hirsch and Lieutenant Commander Havraha 
cha’AAnikh 

 

Good Morning, Afternoon or Evening movie fans!  We’re 
back for another issue of the USF Movie Review!  If you’d 
like to contribute please send us an email at 
USFPADD@gmail.com with “Movie Review” in the subject.   
ights! Sound! Action! L

FltCptRJHirsch:  Welcome one and all to another 
joyous, and hopefully humorous and informative movie 

e of review.  I'm Fleet Captain Rylan Hirsch and with m
course is the future host with the most... Havraha 

cha'AAnikh. Before we begin the movie review we'd like to both say Congratulations to 
oice!  Way to go Styre.  RearAdmiral Styre for getting into the school of his ch

FltCptRJHirsch:  So... Hav... What have you seen? 
Havraha:  I hate to admit I haven't seen much.  On top of 
that, I failed to see The Mummy 3!  Despite the Yeti factor. 
FltCptRJHirsch:  Bad bad... I went and saw that just so we 
could talk about it!  ::slaps you with a wet noodle:: 
Havraha:  Well, I suppose I could have seen it if I knew you 

o ? :-p we were g ing to do so!  Lack of communication much
Havraha:  Fine then!  What'd you think of mummy 3? 
Havraha:  I may still see it for the Yeti factor, after all. 
FltCptRJHirsch:  Well... where to begin... the 20 year old kid 
of the hero McConnell was a bit too much since Brandon 
Frasier still looks like he could play a recently graduated 
college student. 

 Havraha:  LOL
FltCptRJHirsch:  However, I thought it was interesting how 
they integrated the Terra Cotta warriors into this, and the 
building of the Great Wall of China. 

p. Havraha:  Really.  So he's effectively an Imote
Havraha:  With his own little army of doom? 
FltCptRJHirsch:  Well here's the thing... he's one of the emperor's of China... not one of 
the nice one's I guess. 

ale factor went up. FltCptRJHirsch:  And it's Jet Li... already there the movie sc
 dHavraha:  Who oesn't typically play bad guys, does he! 

FltCptRJHirsch:  And then we have Michelle Yeoh from Crouching Tiger Hidden Dragon... 
raises the movie scale up a bit more. 
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FltCptRJHirsch:  This is the second time that I've seen him play a bad guy...the first time 
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te nicely I think for the cheese factor to have 
le e included these two martial artists was extraordinary. 

OT

h hope for this film, and was 
u will be 

Hmm ... so a thumbs up, then
a thumbs 

speaking of cheese factors, Tropic 

c

up to 

c sounds funny on 
s 

 Other times, it’s impressive the amount of 
4 

was in The One. 
Havraha:  Well that doesn't count, cause he was also the good guy in that movie too. 

 Havraha:  LOL
Eh... but it was done quiFltCptRJHirsch:  

been off the sca .  And two hav
FltCptRJHirsch:  But to the Yeti... 
Havraha:  :-D 
FltCptRJHirsch:  They rocked! 
FltCptRJHirsch:  Yes I know... the cheese factor... but for a CGI 
created creature... it rocked.  
Havraha:  WO !  Well I’m definitely going to see it then! 
Havraha:  Alas, what was the overall movie though?  I've heard the 
script was bad. 
FltCptRJHirsch:  It was eh... action surrounded by love of family, love 
of a girl... trying to get away from the cheese factor of an additional 
sequel... it could have been much much worse than it actually was. 
FltCptRJHirsch:  Overall I didn't have muc
surprised. But... I'd still wait to go see it on cable... although yo
impressed. 

Havraha:  . 
FltCptRJHirsch:  Okay... I'm feelin’ generous...
up. 

m ... Havraha:  Hmm
Thunder. 
FltCptRJHirs h:  Please tell me you did not... 
Havraha:  Oh, I did. 
Havraha:  LOL 
Havraha:  Where to begin with this one.  I really don't 
know.  
Havraha:  It is, 100%, one of Ben Stiller’s films.  I mean, if 
you think Zoolander is stupid (which you should), then you 

pwill think this is stu id. 
Havraha:  Because it is. 
Havraha:  Now whether or not you'll find it FUNNY is 
you... but in my opinion, it tried too hard. 
FltCptRJHirsch:  I like the few brain cells I have left... 
never saw Zoolander. 

dancing, air-butt-slappin’ to rap musiHavraha:  Tom Cruise in a fat suit 
 inpaper, but  practice it actually isn't.  Unfortunately, they never figure this out, and he end

up doing it several times throughout the film. 
FltCptRJHirsch:  ::raises a brow:: 
Havraha:  Areas like that, the film's just dumb. 
cameos they were able to get from stars like Jennifer Love Hewitt to just pop on screen for 
seconds and do nothing more than exist. 
FltCptRJHirsch:  I suppose if the price is right. 



 

 
17

 the movie is the cold-start 

me. 

e focus and 

in ne can understand. 

e to the 

 

 flies that have aspirations of adventure like one of the fly's 
arhart... the first time, not the last. 
 I haven't even heard of that. 

Havraha:  But, r the most part, the absolute funniest  fo thing in
of the film... it starts and you don't even realize it, as the movie previews lead into "fake" 
movie previews staring the characters in the movie. 
Havraha:  Those were great.  But, overall, the film was stupid. 
FltCptRJHirsch:  So I guess a definitive thumbs down. 
Havraha:  Now, there's also a lot of controversy in this film.  Specifically, over the liberal 

 in general. use of "retard", and making fun of handicaps
FltCptRJHirsch:  I thought I saw something on CNN about that... 

 declare that these are ... well ... warranted. One character DOES Havraha:  I can officially
do an over the top, retarded stereotype in the film several times .... 
FltCptRJHirsch:  Let me guess Jack Black. 
Havraha:  No, actually!  Ben Stiller!  Jack's roll in the film is incredibly minor... 
FltCptRJHirsch:  Really. 
Havraha:  Jack rolls around the jungle going cold turkey from lack of drugs. And 
complaining that people only ever laugh at his farts. 
Havraha:  He plays the stereotypical low self-esteem celebrity, but ... nothing is really 
done with his character beyond that. 
Havraha:  and on top of that, some of the funniest conversations revolve around 
discussing exactly how “retarded” one should act professionally. 
Havraha:  Lines in the film such as "you never go full retard" are 

ny eard in context, and kids are going to go to indeed quite fun  when h
school repeating these lines, making fun of handicaps. 
Havraha:  So yeah, I actually agree the movie goes overboard.  And 

’s only actually funny 10% of the tion top of that, it
FltCptRJHirsch:  ::Nods:: 
Havraha:  So, thumbs down from me.  Though, once again, the Iron 
Man deliver's an impressive performance. 
FltCptRJHirsch:  ::shakes head:: 

Havraha:  I actually found it ironic how th
controversy of the film was the word “retard”, and not the 
fact that someone is black faced, saying lines in an ethical 
stereotype  a way no o
Havraha:  So color me surprised. 
Havraha:  So what else have you seen? 
FltCptRJHirsch:  Let’s see... last week I saw Fly M
Moon. 
Havraha:  Oh, do tell 
FltCptRJHirsch:  The week before that was Clone Wars 
Havraha:  Tell me about Fly Me to the Moon 
Havraha:  Were you flown to the moon at all? 
FltCptRJHirsch:  LOL Well let’s say that I didn't realize that 
this film was supposed to be shown in 3D... I saw that some
theaters had it that way... but my local one didn't say that. 
FltCptRJHirsch:  So I was surprised to have glasses handed 

to me.  The movie is about three
o grandfather. Wh flew with Amilia E

Havraha:  ohhh... well that’s odd,



 
Havraha:  Wait, there's a fly? 
FltCptRJHirsch:  They are all flies. 
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't think it was well publicized.  
d excellently done.  It’s on par 

lo

ble 

 g

ilm. And best of all the 3D glasses didn't 

tainment factor. 

on it now? 
n... but 

y vie. 

 w

 

Havraha:  Umm ... I have to admit I've never even heard of this movie. 
Havraha:  LOL 
FltCptRJHirsch:  LOL, don’t worry I don
FltCptRJHirsch:  So the drawing, definitely CGI crafted, an
with my be ved Pixar. 
Havraha:  Hmmm, interesting indeed 
Havraha:  So what was the plot behind this movie, then? 

 fliHavraha:  Just es and Amelia Earhart? 
FltCptRJHirsch:  Indeed, Illuminata Pictures did quite well, and it was how they were a

tion. to show space history while keeping little kids atten
FltCptRJHirsch:  No no... summer of '69 and three friends (who are flies) want an 
adventure... and happen to be next to Cape Canaveral. 

l thHavraha:  Wel at’s a strange concept indeed 
FltCptRJHirsch:   t is is a mission to the moon they set off unknowingly that So... being hat th

they will be one for awhile. 
FltCptRJHirsch:  Enter into the capsule with the Astronauts and have an 
adventure. 
Havraha:  LOL 
Havraha:  So, you liked it a lot, eh? 
FltCptRJHirsch:  Of course there are the normal 3D tricks that go along 
FltCptRJHirsch:  Tang in space forming blobs that one little fly sucks up 
and is trying to be in your face. 
FltCptRJHirsch:  Overall... hooray that they are teaching something of 
the space program to kids trying to peak interest. 

tRJHirsch:  It was a good fFltCp
give me a headache like the ones from Captain EO did. 

 a matinee price movie, and a FltCptRJHirsch:  Definitely
rthumbs up for the kids ente

Havraha:  Excellent. 
Havraha:  So now, our final film.  Star Wars: The Clone Wars.  
Havraha:  I say:  woot! :-) 
FltCptRJHirsch:  Okay...  

at?  you gonna hate Havraha:  Wh   Are
FltCptRJHirsch:  No no... I mean its Star Wars come o
I have to sa  that the book is definitely better than the mo
Havraha:  There's a Clone Wars book? 

 Yep FltCptRJHirsch: 
Havraha:  I was under the impression this was a kids' 
cartoon! 
Havraha:  Why ould they write a novel for it? 
Havraha:  lol 
FltCptRJHirsch:  Because the screen play was adapted into 
a book. 
FltCptRJHirsch:  And did a bit more justice.... you didn't get
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t 

 

TS 
, Anakin was actually NOT 

d 
h

t. 
 

iou  t

 
s help sooner.   

e 

the amoun of respect that Anakin had for the men under his command in the movie as 
much as you did in the book. 

e if I was hearing wrong... but was McGregor doing the voice FltCptRJHirsch:  And... tell m
of Obi-Wan? 
Havraha:  No, Fred Flintstone was.  Or at least, the guy who does the current voice of Fred
Flintstone. 
Havraha:  His specialty is filling in for actors who can't return for cartoons or video games. 
Havraha:  He's quite good. 
FltCptRJHirsch:  He was quite good. 
Havraha:  It all is ultimately futile to me.  The Clone Wars, in my opinion, kicked the PAN

an n packedoff Episode 1, 2, d 3.  It was funnier, it was more actio
annoying... and I loved his new little padawan for some reason. 
Havraha:  The opening 15 seconds with the announcer ... eh, sounded horrible. But after 
that, when they spent the first 20 minutes on one clone wars battle alone, that's when I 
went "Holy crap, this movie is actually FOCUSING on something!" 
FltCptRJHirsch:  So... the movie I thought was good. 
FltCptRJHirsch:  Because she is the way that Anakin should have been portrayed.  Ha
they done im as they had done Ahsoka it would have rocked the Star Wars world. 
Havraha:  No no no, Anakin was portrayed perfectly here.  He and Ahsoka Tano have a 
very nice relationship going on, where she's just as reckless as he is... but she understands 
judgment.  He, on the other hand, has experience and power. 
Havraha:  They balance each other out, pull one way and the other on each other. 
Havraha:  It just "works", as a relationship.  Better than the Obi-Wan/Anakin one.  I loved i
FltCptRJHirsch:  I know... but what I'm saying is that if they had done that with the Anakin
character in the live action films... Hayden would not have been critiqued as hard as he 
has been. 
Havraha:  Now, it drops off towards the end.  Gets very kind of anti-climatic, and in a 
way, it becomes way too obv s it’s a pilot o a cartoon, where at the beginning I was 

actually "buying it" as a movie.  After about midway 
through the film, after “Asajj Ventress” who most casual 
Star Wars fans probably won’t be familiar with… 
Havraha:  that’s where it started losing steam ... and 
then it just felt like it was exhausted as a movie towards the 
end. 
Havraha:  But it was DEFINITELY worth seeing.  It wasn't 
this horrible death to the star wars universe that reviewers 
are trying to make it seem like.  It was VERY fun. 
FltCptRJHirsch:  Agreed, and I think the writer Henry 
Gilroy should be commended for how well he has done.  It
was unfortunate that Lucas didn't seek hi

FltCptRJHirsch:  He could have saved three critical movies to the saga. 
Havraha:  So, thumbs up to me.  If someone were to ask me "Which would you want to 
watch right now:  Clone Wars, or any one of the Prequel Films?" I'd say Clone Wars in a 
heartbeat. 
FltCptRJHirsch:  ::Nods:: Agreed.  Thumbs up for me as well. 
Havraha:  It's also worth noting that the next saga of Star Wars, entitled "Star Wars: Th
Force Unleashed" comes out next month in novel and video game form. 
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eing raised by 

tinue on Cartoon Network 

 we have one film to talk about next 

shed 

or...  
w it 

  But then it won’t be t e USF Movie Review! 
Havraha:  SHHH! 
Havraha:  They'll never know! 
FltCptRJHirsch:  That's all from us for now.  See you next month, at the movies! 
Havraha:  :-)  

Havraha:  In case you readers are curious, it's an in-between story taking place during the 
dark times between Episode 3 and 4, focusing on a secret apprentice b
Darth Vader. 
Havraha:  I encourage you all to check it out, since it looks like it will be very good! 
FltCptRJHirsch:  Which does sort of blend with this whole Clone Wars film... 
FltCptRJHirsch:  he gets a padawan there.... 
FltCptRJHirsch:  he gets an evil apprentice here.... very interesting... 
Havraha:  Indeed!  And the Clone Wars television series will con

 Din the fall, and in ecember, a Clone Wars fighting game will be coming out for the Wii. 
Havraha:  So, lots to look forward to in Star Wars world in the coming months. 
FltCptRJHirsch:  So any movies you're looking forward to seeing now that the Summer 
Blockbuster season is done? 

y haven't checked. Havraha:  Absolutely none.  LOL.  I honestl
FltCptRJHirsch:  Well I did go see Disaster Movie.  So
month. :) 
Havraha:  I'm rabidly awaiting The Clone Wars series to start, and for the Force Unlea
to be umm ... unleashed, upon us.  Beyond that, nothing. 
Havraha:  Disaster Movie?  Are you sure? 

ay see it one way or another. ;-) Havraha:  LOL.  I m
FltCptRJHirsch:  And there is Ig
Havraha:  Read the Force Unleashed novel and play the game, and we'll revie
together here! 
FltCptRJHirsch: h
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TEMPORAL  LEAP 
Innovative Education of the 29th Century 

 
pre ts 

by Wilhelmina Sternenschnuppe 

mputer operations.  I'm sure my next guest on the 

4  century!  

sen
 

“A Covert Look at 24th Century Technology” 
 

 
 Live long and prosper!  Wilhelmina Sternenschnuppe reporting with yet another part of our 
new and exciting eduction program.  I would like to give my thanks to everyone that has made  reply 
to last months interview.  There sure seem to be many Cam Sanantonio fans out there.  In addition, 
I have been asked to contribute to another program sponsored by the Federation's Neurological 
Museum, due to my first hand encounter with the Commander.  Apparently, my observations and 
the fact I was allowed to touch his crystalline hair while I was there have made me an invaluable 
first-hand witness. 
 Again, I would also like to address a couple of frequently asked questions that were among 
the enthusiastic response of our viewers.  1) The most frequently asked one was about the still 
operating on the Lexington and Commander Sanantonio's reference to their being one on every 
ship.  To answer, no, I don't recall there being a citation for 'Operating a Starship Under the 
Influence'.  However, drinking while on duty was strongly regulated. At times, there was reason to 
share in a drink due to the visit of an alien official or similar situation, but there were strict rules on 
drunkenness.  As I recall from the Lexington particularly, consumption of real alcohol was limited to 
officers on leave or those being on 'Extended Off Duty'.   2) Yes, that was a major miscalculation of 
the Commander on the front part of the envelop.  Don't be so surprised, geniuses have more 
important things to do than perfect their ability to do long additions.  -  Of course, you school-aged 
children still have to learn that basic skill for mathematics, simply so you can understand the more 
complex issues of problem solving and co
program will fully agree with me on that. 
 Therefore, get yourselves ready for another leap into the past.  You might be shocked, but 
this one is an educator aside from a former Starfleet officer... a professor even.  So, keep your 
hands and feet inside the ride and enjoy our visit with one of the most beloved personages from the 

th2
 
 

Part III – Robb Clemens 
 

 The word 'Professor' might strike a certain unhappy chord with some of you, depending on 
what experience you have had with teachers in your past.  However, this one is just as much fun as 
he means business  -  Robert Clemens, II.  At the time of my visit, Professor Clemens has been 
retired from Starfleet with the rank of Fleet Captain and is living on Betazed, where his late wife had 
grown up. 
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Keirana and Robb Clemens on a Holodeck adventure 

have to admit, I'm 

 
--==/\==-- 

 
 I materialize on the deck of Professor Clemens' house.  The view over the Opal Sea is 
breathtaking, and I find myself looking out over the waters, while I enjoy the breeze coming in from 
the ocean.  I have been on Betazed several times, but never is this particular spot.  A few moments 
later, I hear the door open behind me, and I turn around to see the Professor looking at me 
uriously.  c

 
 

rofessor Robb Clemens:  Professor?  P
 

r. Wilhelmina Sternenschnuppe:  You must be mistaking me for someone else. D
 
Robb:  No... Although, I didn't expect you so soon.  I was advised that I would meet you from a 

rmer officer of mine.   fo
 
 
 He offers me a seat in one of the over-sized, stuffed chairs on the deck.  I 

ther flabbergasted at his words.  Who could have possibly told him about me? ra
 
 

r. Mini:  I'm Doctor Wilhelmina Sternenschnuppe. And you're Professor Clemens, if I'm correct. D
 

obb:  Nice to meet you, officially.  R
 
Dr. Mini:  A former officer of yours?  I assure you, no former officer of yours should have been able 

 tell you about my visit.  -  So... you know why I'm here, and where I come from? to
 
Robb:  Not so much the why... but from the future yes. And the Fogarty brothers are anything but 
our usual run-of-the-mill officers. y

 
 



 
 Aha!  There is the culprit!  Falco Fogarty evidently remembered my visit.  That could mean 
trouble.  We had considered him possessing some sort of 'black box' devices that recorded events, 
even in the event of him being unconscious or dead.  But it was a calculated risk.  Now, we have to 
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here over closer, pondering if I might need to recheck the settings on 

ries about inventions of the 24th century.  I'm 
ere to interview you about the Dhouti class starship.  

 
*PICTURE OF THE DHOUTI CLASS 

  You're talking about the USS Excelsior as the failed project? 

rethink a few matters.   
 I motion the camera sp

e memory erasing device. th
 
 
Dr. Mini:  Yes, I'm from the future. I run a holovision se
h
 

obb:  Ahhh, the Dhouti...  A wonderful ship. R
 

 
Dr. Mini:  Yes, indeed.  It had some very interesting technology incorporated.  Would you mind 

lling me a bit about why you decided to develop the ship? te
 
Robb:  There are a few engineers that have been wanting to resurrect the Transwarp project that 
failed so many years ago.  As with many engineers, the possibility of making a ship go faster than 
any other is a prize almost too good to pass up.  And then of course, there was USS Voyager, which 
ad gone missing at the time. h

 
r. Mini:D

 
Robb:  The jury is still out of it that project was a failure, or an act of sabotage.  But yes... I can 
remember reading about the ship in my engineering courses at the Academy and wanting to be 

ere for her test flights and get into her engine. th
 

r. Mini:  Yes, I remember that as well... though...  D
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ilure in the future.  It is very unfortunate that I cannot share the information with him.  I'm sure he 
ould be interested, as would many others. 

he faster than warp speed travel a reality for 

 their first invasion.  It was 

r. Mini:  And that is exactly what my viewers would like to hear. How did you do it? ... Of course, I 

her 

 clause. 

r. Mini:  Many of them do, if they watch PEA's documentaries regularly.  But yes, it's fairly 
ommon knowledge in my time what the delta stands for, even among 'common' people. 

ure' makes me smile.  Always the educator, even when he doesn't really know 
peaking to.  The more I talk to him, the more relaxed I am getting.  He's an 

xtraordinary man. 

r. Mini:  How did you overcome the stress on the ship once in the conduit?  I mean, it's no Borg 

ural Integrity Field generators, the ship had dual 

r. Mini:  you had set yourself, or did Starfleet urge the 

u were the lead researcher? 

arismatic of a man as I know from the history books.  

 
 
 I have to stop myself from saying anything I know has been found out about that project's 
fa
w
 
 

r. Mini:  So, it was your ambition then to make tD
Starfleet with this new design? 
 
Robb:  Transwarp was just another step towards effectively utilizing the space/time continuum.  And 

e knew it could be done with the analysis of the Borg cube remains fromw
just a matter of finding the right combination. 
  
D
understand you did have help with the development. 
 
Robb:  Yes, a project of this caliber takes many.  But what we ended up finding is that with a 
concentrated burst of tachyons it was possible to open a transwarp conduit.  Once the conduit was 
open a ship could slip in and utilize the same warp field as current to propel itself forward at a hig
rate of speed simply because it was another more efficient travel through space and time.  As your 
iewers already know, the delta that we have on our chest for starfleet represents the folding of v

space time, which allows us to propel faster than light and not fall into Einstein's space travel
 
D
c
 
 
 His short 'lect

e audience he is sth
e
 
 
D
cube...  
 

obb:  It was just a simple increase of the StructR
cores to support the power usage. 
 

  I see.  -  So, was this just a personal goalD
research more or less? 
 
Robb:  It was a fleet sanctioned project. 
 
Dr. Mini:  And yo
 
Robb:  Correct. 
 
Dr. Mini:  You are as intelligent and ch
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ind then. 

r. Mini:  I don't think so...  

der 

at I'm not here for a personal 
terview on his life, but rather his development on the Dhouti. 

ni:  I have to admit, I'm curious.... Borg technology couldn't have been easy to deal with, 

l in connection with that?  -  Many of PEA's regular 
ur implants somehow influence you on how 

obb:  No, they are just a tool to keep me mobile.  

teresting to see that he doesn't like making a big deal of himself. 

r. Mini: about the testing and eventual field usage of 

obb:  It was that and more.  It was however unfortunate that upon her maiden voyage she was 
rned unharmed on the saucer drive. 

r. Mini:  An unfortunate occurrence.  

ontinue the project years later to perfect it with the use of different technology.  

obb: ed as to 
hat happened. Only that it was not a design flaw.  

 

Robb:  History was far too k
 
D
 
 
 I find myself drawn in a bit by the open smile and the grey eyes of the Professor.  No won
he was so well liked at the Academy.  One could easily take him for a ladies man, yet, he was 
lways the picture of moral excellence.  I have to remind myself tha

in
 
 

r. MiD
right? 
 
Robb:  We laugh at ourselves today for the kind of precautions that we took back then to ensure 
that none of the fleet was infected by the Borg programming.  We knew very little back then as 
ompared to today.  But yes, once we got past the precautions, getting the power distributions to c

match that of the Borg cube was challenging, but surmountable. 
 
Dr. Mini:  May I ask you something persona
iewers know your life story....  I'm wondering... do yov

you look at the Borg... or their technology? 
 
R
 
 

Again, I cannot deny noticing his humble attitude displayed by his rather short answer.  It's  
in
 
 

  So... one last thing about the ship. Tell me D
the Dhouti. Did it prove to be all you had hoped for? 
 
R
lost.  Although, her entire crew was retu
 
D
 
 

I can't help but smile a bit, since I know that Admiral Joseph Teran, his oldest son, did  
c
 
 
Dr. Mini:  Could you enlighten us about exactly what had happened? 
 

  Unfortunately, it was deemed a matter of Starfleet security, and I was never advisR
w
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 is Slipstream technology, which shall be tested soon from what I hear from 
y contacts at R&D. 

ke his ability to 'hear' my thoughts will help him in any 

o 

  I still have some left overs of Nova Burritos for you to take with you on your journey home. 

ublic Education Agency database, serial number 7854449-003, on the Federation Holonet. 

 Once again, I have to admit it is rather unfortunate that I cannot reveal more about the 
findings on the projects demise, although the files he was referring to have been declassified in the 

cent years. re
 
 

r. Mini:  You think you'll ever take on another project like that? D
 
Robb:  You should know I'm a telepath as well. ... No, Transwarp is a project that is now long past, 
the wave of the future
m
 
 
 His friendly warning made me chuckle.  Most people with telepathic powers might not feel 
scruples at sensing what I was thinking, but in his usual manner, the Professor seems to have a 
higher order of conscience.  However, it's not li

ay, once I apply the memory erasing device. w
 
 
Dr. Mini:  You should know that I'm aware of your abilities.  It's nothing that worries me.  -  I have t
be honest... I tremendously enjoy visiting the past and getting to meet people like you in person... 
but I have to say, I had hoped to get to sample your cooking skills.... I've heard they're unmatched in 

is sector. th
 

obb:R
 

r. Mini:  Leftovers?  Hmm....  I suppose if that's all you're willing to offer.  D
 
 
 I have to admit, I am a bit disappointed, I had hoped for a freshly cooked meal and some time 

 chat outside the interview, but I suppose that would be pushing the boundaries of my assignment.  to
 
 

r. Mini:  Well, it was very nice talking to you, Professor Clemens. D
 

obb:  Likewise .... Doctor.  R
 
 
 After he went back into the house and fetched me the Burritos, I exposed him to the memory 
erasing device and left in a flash of light.  I couldn't help but think about his children and their 
accomplishments.  It pained me a bit that he never got to see how much he had influenced them, or 
the many other young minds. 
 Don't worry!  He was still able to play a valuable role in Betazoid political refinements in the 
coming years.  I would highly recommend for anyone to watch his life story as part of the 
documentary series Making a Universal Impact, as well as part 8 of the series Man or Machine.  
Both give unique looks into who Professor Robb Clemens truly was.  I feel certain he would approve 
of the way he was portrayed in both series, and the valuable lessons being taught with the help of 

em. th  
 For a full-length holorecording of this particular interview, please refer to the Federation 
P
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 DON'T MISS MY NEXT ARTICLE, in which I interview Jonas Brent on the USS Lexington, 
where he serves as CO with the rank of Fleet Captain at the time of my visit. 
 

___________ _________ __________________________________
----------------------------------------------- 

 
If you would like to see an interview with a particular inventor or designer in line with this program, please submit your 
suggestions to usfpadd@gmail.com, subject: “Temporal Leap Interview Request”.  USF PADD staff will print the 

request on a plastic flimsy and bury it in a specially designed capsule under the rosebushes outside the PADD's main 
building, where it will be dug up by PEA staff 500 years later.  Please be advised that not all requests may be recovered 

and acted upon. 

*USS Dhouti imagery portrayed by the Phalanx Class Battlecruiser designed and created by Dak Phoenix.   

Text copyright © PEA, 2892 
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USF Simulation Tips 
Operate Those Operations! 
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 I 

what ation officers! 
 

e 

ficer. 

nsive 
programs off, and insuring that all of the ships systems are ready to respond to ANY 

uation. 

h time, everything is checked and 
ouble checked, anything can happen and often does!  

   

 
As an Operations officer aboard the Lexington,
understand how complicated it is to figure out 
exactly what my actual “job” is during the sim.  
Star Trek itself has had no shortage of Operation 
officers, but they always seem to simply be “that 
guy who sits next to the helmsman”.  Happily, USF 
Carrissa comes to us again with another addition 
of USF Simulation Tips to help us understand exactly 

we need to do as Oper
- Editor in Chief 

 
Operations or Ops: 
This station also located on the bridge, oversees 
and controls most of the different departments on 
the ship. Shipboard operations require the 
allocation of resources such as power or sensor use 
that affect every department on board. 
It provides the officer on duty of all current major shipboard activities and status reports of all 
departments.  The ops console computer will oversee automatic and routine functions leaving th
officer to make decisions beyond the capability of the computer.  Rerouting emergency power 
from one department to another, or shutting down non essential systems on specific decks, and 
maintaining the overall functioning of the main computer are just some of the duties of the Ops 
of
  
Yellow alert 
 Usually invoked in preparation for a possible crisis situation, it is a shipwide alert and it prepares 
personnel for a possible red alert. Yellow Alert - you HAVE to watch the level 4 diagnostics and 
report any oddities, and remember to shut down any leisure activities even for civilians unless the 
CO specifically asks for a silent yellow alert. Also terminate anything that may be happening that 
may increase the chance of accident of damage to crew or ship. This includes knocking exte
holodeck 
sit
  
Red Alert  
Red Alert is invoked during states of emergency that may endanger the vessel or the crew, 
impending emergencies, or combat situations. This is crunc
d
 
(( taken from TOS: Court Martial.  Orig. Air date: 02/02/1967)) 
Please email usfcarissa@aol.com  with any requests for information on anything Sim related 

ncerning any department, and I will be happy to include your questions in the next issue. co



 

USF Cookbook 
 
By Ret. Fleet Captain Robb Clemens  
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Greetings to one 
and all, I 
welcome you to 
another 
adventure of 
culinary sharing.  
Please remember 
that this is the USF 

Cookbook and that everyone is 
encouraged to submit their favorite 
recipe’s regardless of rank.  There is no 
generalized theme, and there is definitely 
no stylized food type that we’re looking 
for, just the wholesome goodness that you 
call home cooking.  Let the cooking 

egin! 

 
gredients: In

 
 peeled 3 pounds medium-to-large shrimp,

4 quarts water 
16 ounces beer 
1 teaspoon cloves, 2 teaspoons Old Bay 

rab boil seasoning, 1 ½ tablespoons c
6 fresh tomatoes, chopped 

s in juice 1 8-ounce can whole tomatoe
1 6-ounce can tomato paste 
2 medium-sized onions, chopped 
1 large green bell pepper, chopped 

es, chopped 5 stalks celery with leav
liced 8 cloves garlic, s

b ¼ cup olive oil 
 
Here is another of the original recipe’s 
from the USF Cookbook V1.0, where we 
have another fine recipe from Retired 
Fleet Captain Roel Jere.  Here he explains 
how he was able to get his hands on this 
yummy recipe from Captain Sisko.  “All I 
can say is, this is one of the most amazing 
meals I have yet discovered on Earth.  
Shrimp!  Peppers!  Onions!  Tomatoes!  And 
spices, spices, spices!  Anyway, I got this 
recipe from the late Captain Benjamin 
Sisko during a trip to Deep Space Nine.  
He was kind enough to take time out of his 
busy schedule to cook this authentic 
dinner for me, in exchange for my 
hasperat recipe.  I’d say I got the better 

1 tablespoon butter 
easoning 2 more tablespoons Old Bay s

 ¼ cup ground black pepper
1 tablespoon cumin 

ice 1 teaspoon pickling sp
1 teaspoon rosemary 

r 1 teaspoon cayenne peppe
uce 1 teaspoon Tabasco sa

 cups uncooked rice 2
 

irectiD ons: 
 Start by peeling the shrimp and then 
boiling them in a mix of 4 quarts water with 
8 ounces of beer, as well as the cloves, 
Old Bay seasoning, and crab boil. 
 While the shrimp boil (and they only 
need to turn from gray to a nice pinkish 
red) prepare a DEEP skillet by simmering 
the garlic in the olive oil, then add the 

end of the bargain. 
 This meal is huge, keep in mind – it 
can serve 8 people easily, so be ready for 

ftovers.”  Prijatnogo appetita! 
peppers, onions, celery, and the butter. 
 After that has combined, add the 

rimp
le
 

Sisko’s Shrimp Creole with Mandalay 
Sauce 

 

sh  and stir through. 
 Next add all the fresh tomatoes, the 
canned tomatoes, the tomato paste, and 
a ½
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cup of the liquid you used to boil the 
shrimp (don’t forget to strain it).  Simmer 
on low for at least 20 minutes.  After the 
tomatoes have begun to dissolve, add the 
rest of the seasonings and continue 
immes ring. 

 After another ½ hour of simmering, 
draw off about 1 cup of liquid for the rice 
and combine with the remaining 8 ounces 
of beer and 2 more cups of water to 
prepare the rice.  While the rice cooks, 

ontinc ue simmering the Mandalay sauce. 
 When everything is done, serve the 
Mandalay sauce over the rice. 

With the Labor Day holiday, it’s the official 
adieu to Summer and hello to Fall and 
Winter.  It’s during these times that I can 
remember my Great Grandmother, and 
now my mom making the infamous Shoo 
Fly Pie.  So enjoy, from my family to yours.  
Guten Appetit! 

Great Grandma Clemens – Shoo Fly Pie 

2 sweet pie c
2 cups flour  
1/4 teaspoon salt  
1 1/2 teaspoon sugar  
1 cup solid vegetable shortening  

rust (see recipe below) 

1/2 cup ice water  
For the crust: In a mixing bowl, combine 
the flour, salt and sugar. Add the 
shortening and work it through with your 
hands until the mixture resembles coarse 
crumbs. Add the water, 1 tablespoon at a 
time, and work it in with your hands until 
you have a smooth ball of dough. Wrap 
the dough in plastic and refrigerate for at 
least 30 minutes. Remove the dough from 
the refrigerator and place it on a lightly 
floured surface. This recipe will make two 
pie crusts.  

For the whole pie crust: Roll out the dough 
on the floured surface into a circle about 
14 inches in diameter and 1/8 inch thick. 
Gently fold the circles of dough in half 
and then in half again so that you can lift 
it without tearing it, and unfold into a 9-
inch pie pan. 

Shoo Fly Mixture:  
 

syrup 2 bottle of molasses or 
r 2 ½ cup boiling wate

1 bottle of molasses 
 table spoon baking powder 1

 
Add all the ingredients together in a large 

owl and set aside. (Enough for 2 pies) b
 
5 sticks butter or margarine 

f Brown Sugar 1 box (1 lb) o
r 4 cups flou

 tsp salt. 1
 
Add all the ingredients together till it forms 
a crumble mix.  Take 1 cup of mix out and 

t aside. se
 
Preheat over to 350 (This should be done 

 a thick pie pan) in
 
Add crumble mix to the liquid mixture. Stir 
blending all ingredients. 
Add another cup of molasses or syrup to 
the bottom of the piecrust.    Add enough 
to coat evenly.  Add in liquid ingredients 
to the top of the pie.  Add in ½ cup of 

rumble mixture from what was set aside.   c
 
Place both pies in the oven for 1 hour.  
Test the middle to make sure it comes out 
mostly clean. (Will not come out totally 
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clean because of the molasses o
Here is a recipe from Lieutenant 
Commander Ziz Tiesha from the USS 
Lexington. This is one of her favorite cakes 
to make for her and the family,  it sounds 
yummy! Smakelijk eten! 

r syrup at the bottom of the pie.) 
Combine butter, brown sugar, white sugar 
and milk in a saucepan.  Bring to a 
boil. Add gradually the powdered sugar 
and salt in a mixing bowl.  Beat to 
spreading consistency. Add vanilla.  This 
may not seem too thick when you put it 
on a cake but it hardens to a kind of 
fudge topping

Wacky Cake 
  
3 cups flour 
2 cups sugar 

r 5 Tablespoons Cocoa powde
ng Powder 2 teaspoons Baki

teaspoon salt  1 
  
Mix well in a 9x13 baking pan (no need to 
grease and flour the pan)   

ake 3 wells for the following ingredients: M
  

s Vinegar 2 Tablespoon
3/4 Cup Oil 

teaspoons Vanilla  2 
  
Cover all this with 2 cups of water.  Mix 
well so all the dry ingredients are mixed in.  
Bake in oven at 350 degrees for 35 to 45 
minutes.  I know there are no eggs in this, 
and its not suppose to.  But it is a very 

oist Chocolate cake with a bite to it.   m
  
You may eat it plain of I like to use 

nuche frosting: Pe
  

nuche Frosting Pe
  
1/2 cup butter 

n sugar 1/2 cup packed brow
 sugar 1/2 cup white

1/4 cup milk 
oners sugar 1 3/4 cup confecti

1/4 teaspoon salt 
4 teaspoon vanilla 1/
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ts 
.  I should have noted it right out of the gate, but I didn’t want to load you down with too 

uch. 

ay notice that the colors aren’t the same.  They’re slightly different.  Let 

 

                                         

ow diagnose this illness.  This, is the doings of the color profiles. 

r 

 

r 

our monitor, and I’m going to tell you how right now. 

  

 
Oh happy day, my pupils!  I’ve been meaning to tell you guys this for a long time, because it 
absolutely drove me NUTS for several years (and it drove several photoshopping friends of mine nu
as well)
m
 
The truth of the matter is:  if you’ve saved an image in Photoshop and tried to view it in another 
program, say… AOL, you m

e show you an example: m

  
 
One of these things is not like the other. If you guessed both of them, then… umm… well, I guess 
you’re right.  The astute eye will notice that the image on the left has a brighter skin tone than the 
image on the right.  The likelihood is you’ll produce an image that looks like the image on the left in 
Photoshop, but once saving it or copying/pasting it, your image will be slightly dulled, muted, or just 
off color.  This is a strange phenomenon that has plagued me and others like us for years, and I can 
n
 
You see, these programs are made for graphic designers, and graphic designers have to work 
across various equipment and in different mediums insuring the accuracy of their color.  To do so, 
Photoshop and other Adobe programs give the option of specifying “color profiles”, or rules for you
colors, to insure they can be accurately reproduced by different kinds of printers, digital cameras, 
programs… whatever.  But just because you’re working in those colors doesn’t mean it’ll necessarily
save it in those colors, and thanks to Photoshop there’s a number of hurdles in a number of places 
that keeps us from getting our colors 100% correct all the time.  If you want to make a bio image o
make images for the sim, you need to get rid of these color profiles and rely only on the colors of 
y
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u’ll 

nd 

ave 

  
n 

 
 

 big 

reen 

 use 

es.  

rofile, you won’t be stuck in it! 

 

K with your corrected Color Settings. 

 
 

B”.  
his will insure that the images you see are being shown for YOUR monitor, not any other monitor. 

 

The first thing I need you 
to do is go to Edit > 
Color Settings in 
Photoshop.   What yo
see may look similar to 
this, but your “Settings” 
may be set to 
something else, a
under “Working 
Spaces”, you may h
some kind of color 
profile selected for RGB.
This is bad.  As you ca
see from mine, you 
want to have your 
“Settings” on “Monitor
Color” and your RGB
Work Spaces set to 
“Monitor RGB”.  Mine 
goes ahead and lists my 
monitor next to it as 
well.  Below you will see 
“CMYK”… there’s a
difference.  “RGB” 
stands for “Red G
Blue”, the colors 
computer monitors
to make images.  

“CMYK” stands for “Cyan Magenta Yellow Black”, which are the colors printers use to make imag
If you’re making something in Photoshop to print, you want to work in CMYK.  To be viewed on a 
computer, RGB.  Obviously, the web qualifies for RGB, but there’s even individual color profiles for 
RGB as well.  By specifying you want “Monitor RGB”, you’re telling Photoshop you want to use the 
same colors your monitor can display.   Under “Color Management Policies”, you want to turn 
everything off, so that whenever you open a document that may be working in some kind of color 
p
 
Unfortunately, as I noted before, Photoshop has many hurdles still in place where they’ll try to sneak
color profiles back into our documents.  We need to take care of those once and for all!  So press 
O
 
Now, go to View > Proof Setup.  Proof setups keep in mind that different kinds of monitors are just 
calibrated differently, and this is something you’ll need to come to terms with too.  The likelihood is 
that if you try to show your friend something you made, she may say the yellow looks too orange, or
whatever.  That’s simply not your fault – it may be because your friend’s color settings and gamma
calibration just isn’t accurate.  You can research this and make sure your things are calibrated as 
accurately as possible, but for the most part Macintosh computers may display things a little 
brighter than say, PCs will.   You can use Proof Setup here to see what they’ll look like on different 
monitors, but for the moment, I  want you to go all the way to the bottom and select “Monitor RG
T
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e to miscalibrated gamma on other monitors.  

ce 
, believe it or not.  In any case, I want 

you to pay close attention to the right side of the window: 

need 

 

aracter, or whatever artwork 

 

ommon – 

y 

 the “Bamboo Fun” package, you’ll get a 
umber of pack-in, free programs to play with as well! 

 
hotoshop, and some ways offer more leeway afterwards than others.  So what about hair? 

 

We’re almost done here.  Now, go to View > Proof Colors.  By making sure “Proof Colors” here is 
checked, it’ll make sure you don’t lose any detail du

las, there’s one last hurdle we need to overcome. A
 
Go to File > Save for Web and Devices.  Now, chances are you’ve never used this handy dandy 
application before, but don’t fret:  it’s harmless.  Save for Web allows you to quickly specify not only 
what format you want to save your images, but at what quality you want to save them, or you can 
view several optimized versions of your image for the web as well.  For instance, this is the only pla
I can go to get my PNGs to have transparent backgrounds

 
 
Do you see the two double arrows I have circled in red here?  I 
you to click on these two arrows.  A small box will pop up, and 
likelihood is, you’ll have “Convert to sRGB” checked automatically.  
Click this again to uncheck it!  This is, once again, more color profile
used by newer web browsers like Firefox, Safari, and in some cases 
Internet Explorer that can affect the way your colors are displayed.  
By making sure Convert to sRGB is unchecked, you’ve finally 
mastered the last of the color profile hurdles.  You can now have 
COMPLETE control over your documents colors, saving you 
headaches when it comes to changing the skin tone of your 
character, or the hair tone of your ch
ou may be personally working on. y

 
 

Coloring Images 
 
So you wanna be an Andorian, huh?  Sorry.  You don’t fit the bill.  You’re not blue, for one!  Maybe 
your goofy character needs to look like Angelina Jolie but have “sapphire eyes” or… whatever 
other kind of cheese you can come up with.  Maybe you’ve found the PERFECT picture for your 
character, but it’s in black and white?  All of these situations have the same solution in c
ou need to color.  But how can you color without coloring over what’s already there? y

 
Well I’m going to tell you from the get go… if you haven’t gone out of your way to purchase a 
Wacom Tablet for your computer, this is going to take forever.  Coloring anything in Photoshop with 
a little ole mouse is time consuming as heck, but it can be done.  However, if you used a Wacom 
Tablet, which is a pressure-sensitive pen, you can set the brush size to alternate depending on the 
pressure, greatly improving the speed of which you can color something and get into those tin
corners with a brush.  The lowest end model Tablet, the Wacom “Bamboos”, sell for under 100 
dollars, and will fit the bill nicely.  In fact, if you purchase
n
 
Alright, let’s get started.  There’s a number of ways you can change the color of something in
P
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.  

, 

d 

the 

n the original image – if you screw up, it’s hard to go back. 

ns 

t 

d of 

w, 
h 

e 

or 

You’ll notice that my actress 
here has dyed her hair at 
one point – it’s lighter near 
the bottom than it is the top
I want it to be the bottom 
color up top as well.  What 
will I do?  Well, search the 
toolbar on the left for the 
color picker tool.  At the top 
where it says “Sample Size”
specify “Point Sample” so 
you can sample only one 
pixel of color at a time, an
then pick color from the 
lower part of her hair or 
swatches panel, if you 
would like that instead.  With 
that color selected, go 
ahead to your Layers Panel 
and duplicate this image by 

right clicking the layer and choosing that option, or dragging the layer onto the “New Layer” icon in 
the lower right hand corner of the of the Layers Panel.  This is always wise, as you never want to work 
o
 
Now, chose the  Brush Tool (hotkey B) and make sure you have a hard Brush tool preset selected:  
none of this fuzzy brush stuff for coloring!   With your hard brush selected, look at the top and see if 
you can find “Mode”.  Chances are, it’ll be set to “Normal”.  Pick it, and scroll through the optio
until you find “Color”.  Chose this instead, and now start painting on her hair.  You’ll realize that 
you’ll be replacing the color with the selected color you have, without destroying the light and dark 

nes!  Use “[“ and “]” on your keyboard to change the size of your brush on the fly if using a mouse! to
 
And tada!  She has the 
appropriate hair tones!  Bu
wait!  What if I wanted to 
change the intensity of this 
color afterwards?  Well, try 
this another way – instea
working directly on the 
image, make a new, blank, 
transparent layer.  Make sure 
the Mode on your brush is set 
to “Normal”, not color.  No
on your layers panel, wit
your new blank layer 
selected, look slightly abov
it.  You’ll notice the Layers 
Panel has a “Mode” option 
as well!  So you see, you can 
set an ENTIRE LAYER to col
whatever is below it!  Go 
ahead and try that.  Paint the hue on the transparent layer with it set to color, and watch as you 
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”, 
riment!  Ultimately, the biggest 

dvantage this method has to the previous method, is that you can smudge around or erase the 

 
w 

 

er 

  
 

londe hair, you’ll need to 
aste some white or blonde 

 

s 
, 

 

f the image has defaulted to 
 

 
 

 

get the exact same effect as before.  However, this time you can change the opacity of the color 
using the Layer Panel’s opacity controls as well.  This will essentially make the color a little less 
vibrant.  If you want even MORE vibrancy out of your color, try putting the layers mode on “Screen
or for even MORE vibrancy than that, try “Linear Dodge”.  Expe
a
color you’ve applied in a non-damaging way if you need to. 

But why stop at just hair?  Ho
about sapphire eyes and 
Andorian skin?  It’s all 
possible! 
 
Of course, as you see, now
you have bigger problems.  
“Pink” whites of eyes?  
Address that with a dark
blue tone over it.  And what 
about white and blonde hair?  
Sorry.  Although you may be 
able to make it gray in tone,
making colors “lighter” than
they are almost never works in 
Photoshop.  If you want your 
character to have white or 
b
p
hair on top of her/his head!  

Sorry!  That’s just the name of the game. 
 
 
But what about a black and white image?  Ah, these are hard, you see.  Black and white image
are often taken with EXTREME contrasts.  Color “soaks in” on different levels of gray in Photoshop
and ignores white and black, so if the face has a lot of white and black on it, the image may simply
not soak up a lot of color if you try to color it!  Well, first and foremost, if you copy and paste an 
entirely black and white image into Photoshop, chances are it won’t actually let you use color!  

WHY?  Because the entire Mode 
o
grayscale!  You can fix that by
going to Image > Mode > RGB 
Color.  Likewise, if you ever want 
to turn a color image into a black
and white image, going to Image
> Mode > Grayscale will do the 
same thing.  If it asks you if you 
want to merge layers, just select 
“Don’t Merge”. 
 
With your document’s mode 
changed to RGB, I can pick a 
color here and start painting on a 
black and white image to show
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e 
 

e 
in 

utral tones of gray better, as seen in the 
ion used only 3 colors – a skin tone from my 

h, but it’s not that simple, is it.  This wouldn’t be USF Photoshop Tutorials if I didn’t go on to show you 
 

-

down 
om 

there, I went on to reduce the brightness to around -40, -50, or even the -60s.  This makes the overall 
image darker, but creates more neutrals in the grayscale for color to latch onto.  So as you see 
below, the high contrast image now has a healthy dose of grays so it can be colored nicely.  
  

you how poorly some black and whit
images “soak up” color.  Here, you
can see how although this BW image 
has been colored, it simply doesn’t 
LOOK like a “real” colored picture”.  
Why?  Because the contrast is simply 
too high.  So is it impossible?  No.  Let’s 
look at some “not so bad” BW 
pictures to see what they actually 
look like, so you can know what’s 
good and what’s not. 
Here, you see that this black and 
white image I got from Google Image 
Search has a lot more gray tones than 
the predominately white and black 
image above.  Although that extrem
contrast beforehand looks beautiful 
black and white images (because its 
covering flaws, I might add), color simply soaks into ne

olored version I’ve produced here.  This colored versc
previous actress, a lip tone from her which I used on her lips and cheeks, and a brown color I picked 
from the swatches for her eyes.  So, coloring black and white images is not out of your reach!  You 
just need to know the limits of what kind of black and white images you can safely color. 
 
A
how to do the impossible, I guess.  What if the image you want to use absolutely “HAS” to be one of
these black and white images that don’t soak up color well?   How can you make it work?  By man
handling the image, of course.  This “is” Photoshop, after all.  So let’s shop some photos. 
 
Duplicate your original image’s layer (to avoid ruining the original, once again) and go to Image > 
Adjustments > Auto Contrast first.  What this will do is make sure your black and white image has a 
healthy balance of dark and light tones from the get go, which will result in more realistic and 
accurate tones of light and dark later on (this is a step I neglected doing above).  You may notice a 
change and you may not, it depends on whether your black and white image NEEDED it or not.  
Then go to Image > Adjustments > Brightness/Contrast.  A box with two sliders will appear, one for 
brightness and … well… you can figure that out.  Make sure the “Preview” box is checked so you 
can see what kind of changes you’re making beforehand.  I reduced the Contrast all the way 

-out whiteness on her face a bit.  Frto the far left, which backed away from the crazy, washed
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 miniature Photoshop Guru!  You don’t even need me anymore!  Boy 
h boy, I’m so proud of you! 

Although the colored image above may look a little pixilated and rough, feel free to use the 
smudge tool to smooth everything together and make it look even.  Congratulations!  You now 
know everything you need to know to ACCURATELY color characters and black and white images!  
Look at you!  You’re already a
o
 

heck back next month for another awesome edition of USF Photoshop Tutorials! C
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